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Références rapides au Guide 
Le Guide du système eTendering du PNUD à l’attention des soumissionnaires est un manuel destiné aux personnes ou aux entreprises qui

souhaitent participer en qualité de fournisseurs à un appel d’offres lancé par le PNUD et qui sont tenues de soumissionner sur le système

d’appel d’offres en ligne eTendering du PNUD.

Pour des références rapides, vous pouvez accéder directement à un sujet spécifique en cliquant sur le lien hypertexte concerné :

• Pour créer un profil et s’inscrire en tant que soumissionnaire dans le système eTendering, veuillez consulter la section intitulée
Enregistrer un profil de soumissionnaire.

• Pour rechercher des appels d’offres et télécharger le dossier associé, avec ou sans compte d’utilisateur enregistré, veuillez cliquer
ici.

• Si vous disposez déjà d’un compte sur eTendering et que vous souhaitez participer à un appel d’offres, veuillez consulter la
section intitulée Procédure de soumission d’une offre

• Si vous disposez d’un compte sur eTendering, mais que vous avez oublié votre mot de passe, veuillez cliquer ici.

• Si vous rencontrez des difficultés techniques en vous connectant au système ou lors de la soumission d’une offre, veuillez
consulter la section intitulée Service d’assistance.

La table des matières donne une présentation détaillée de l’ensemble des sujets couverts dans ce Guide de l’utilisateur.
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1.0  Introduction

La présente section couvre le processus de soumission d’offres, y compris la manière de rechercher et 
d’afficher des événements dans le système, de participer à un événement, de préparer votre réponse 
à un appel d’offres, de procéder à la soumission d’une offre finale et de confirmer que l’offre a été 
soumise.

➢1.1 Aperçu du guide

➢1.2 Qu’est-ce que le système eTendering ?
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1.1 Comment utiliser ce guide

Le présent guide comporte plusieurs sections qui correspondent aux différentes fonctions du système eTendering, par 
exemple, le processus d’inscription, la soumission d’offres, la tenue à jour d’un profil, etc. Une couleur d’arrière-plan 
spécifique est attribuée à chaque section. 

La table des matières donne un aperçu du contenu du document. Elle contient des liens hypertextes vers une page précise du 
document afin que le lecteur puisse accéder directement à la section qui l’intéresse. Chaque section démarre par un aperçu 
rapide de son contenu, avec des liens hypertextes.

Trois types de liens hypertextes figurent dans l’ensemble du document :

- Sous forme de boutons, qui permettent au lecteur d’accéder à la table des matières principale et que l’on trouve en haut à 
droite de la page de chaque chapitre principal, tel que celui figurant sur la présente page.

- Des liens hypertextes permettant au lecteur d’accéder au début de la section courante, que l’on trouve généralement en 
bas à gauche, comme sur cette page.

- Sous forme de mots, qui permettent au lecteur d’accéder directement à un point spécifique lié au texte dans le document. 
Par exemple, en cliquant sur les liens hypertextes de la table des matières ici, le lecteur peut accéder directement à la 
page de la table des matières du présent document.

5

Cliquer ici pour 
retourner à la 

page principale 
Introduction

Cliquer ici pour 
retourner à la 

table des 
matières

Guide de l’utilisateur du système eTendering du PNUD à l’attention des soumissionnaires - janvier 2018



Le module eTendering est conçu pour faciliter le processus d’appel d’offres du PNUD par le biais d’interactions en ligne. Le système vise à 
renforcer l’intégrité et la transparence du processus d’appel d’offres ainsi qu’à rationaliser le processus de passation de marché : les 
soumissionnaires peuvent utiliser eTendering pour soumettre leurs offres, consulter le dossier d’appel d’offres et recevoir des avis 
automatiques du système chaque fois qu’un événement a été modifié. 

Le système eTendering reflète les valeurs fondamentales du PNUD en matière de passation de marché, telles que l’équité, l’intégrité, la 
transparence et la redevabilité. 

Exemples d’avantages offerts par le système eTendering :

✓ Aucune offre tardive n’est acceptée : Le système refuse automatiquement les offres soumises après la date d’échéance.

✓ Offres électroniques scellées : Le système eTendering crypte les offres qui y sont soumises et n’autorise personne à consulter les 
informations fournies avant la date d’échéance de l’appel d’offres.

✓ Estampage électronique des offres : Le système estampe toutes les informations fournies par les soumissionnaires et n’autorise 
personne à modifier l’offre, à la supprimer ou à la compléter après la date d’échéance pour les soumissions.

✓ Rationalise le processus de soumission : Les soumissionnaires peuvent s’inscrire dans le système, récupérer toutes les informations et le 
dossier d’appel d’offres, et recevoir des avis automatiques à certaines étapes du processus de passation de marché. Les soumissionnaires 
peuvent également soumettre leur offre en ligne, la modifier directement dans le système et recevoir des avis automatiques une fois que 
l’évaluation est finalisée et que le contrat est adjugé.

✓ Fournit une piste d’audit : Étant donné que le système eTendering enregistre toutes les activités dans le système, il conserve une piste 
d’audit, ce qui permet de renforcer la redevabilité et la transparence.

1.2 Qu’est-ce que le système eTendering ?
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2.0 Soumettre une offre
La présente section couvre le processus de soumission d’offres, y compris la manière de rechercher et d’afficher des 
événements dans le système, de participer à un événement, de préparer votre réponse à un appel d’offres, de procéder à la 
soumission d’une offre finale et de confirmer que l’offre a été soumise.
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Cliquer ici pour 
retourner à la 
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matières

2.1 Rechercher des appels d’offres
• Connexion et recherche basique

• Recherche avancée

• Téléchargement d’un dossier d’appel 
d’offres

2.2 Participer à un appel d’offres

• Acceptation d’une invitation

• Soumission d’une offre pour une proposition

• Satisfaire aux critères d’un appel d’offres

• Insertion d’articles, de quantités et de prix 
unitaires

• Téléversement de pièces justificatives

• Enregistrement d’une offre pour un usage 
ultérieur

2.3 Soumettre une offre
• Contrôler les réponses

• Soumettre une offre

• Revoir la confirmation d’une offre

2.4 Préparer la soumission d’une offre hors ligne 
(facultatif)

• Soumission d’une offre au format .XML

• Téléchargement d’un dossier d’événement au 
format .XML

• Ouverture d’un fichier .XML dans Excel

• Procédure de réponse à un appel d’offres dans 
Excel

• Téléversement d’un fichier dans le système et 
soumission d’une offre
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Recherche et affichage d’un événement

Acceptation d’une invitation

Cliquer sur « bid on event » [Soumission d’une offre pour un 

événement]

Satisfaire aux critères d’un appel d’offres

Insertion de prix

Téléversement de documents

Contrôle des réponses et soumission d’une offre

1

4

3

2

5

7

6

Les principales étapes de soumission d’une offre dans le système eTendering sont les suivantes :
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Un Guide rapide de soumission d’une offre dans le système eTendering



2.1 Recherche d’appels d’offres –
Connexion au système

Pour commencer à participer à un appel d’offres par le biais du système eTendering, accédez au lien 
https://etendering.partneragencies.org et connectez-vous à l’aide du nom d’utilisateur et du mot de passe que vous 
avez utilisés lors de votre inscription. 
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Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Si vous êtes déjà inscrit(e) dans le système, mais que 
vous ne vous souvenez pas de votre mot de passe, 
veuillez ne pas vous réinscrire.

Si vous avez oublié votre mot de passe, cliquez sur le lien 
« Forgotten Password » [Mot de passe oublié] et créez 
un nouveau mot de passe.

IMPORTANT

Il est possible de rechercher des appels d’offres et de 
télécharger le dossier associé en se connectant à l’aide 
du nom d’utilisateur de compte d'invité Event.guest 
[invité.événement].

▪ Nom d'utilisateur : event.guest, 
▪ Mot de passe : why2change

Pour soumettre des offres, il faut toutefois s’inscrire au 
préalable

Conseil
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2.1 Rechercher des appels d’offres – Aller à 
la page de recherche

Une fois que vous vous êtes connecté(e) à votre compte eTendering, recherchez les événements en cours en accédant au 

menu « Manage Events and Place Bids » [Gérer les événements et soumettre des offres] > Cliquez sur le lien « View Events 
and Place Bids » [Afficher les événements et soumettre des offres].
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Submit Bid

[Soumettre une 
offre]
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2.1 Rechercher un appel d’offres – Utiliser les filtres 
de recherche basique

Cliquez sur le bouton « Search »
[Rechercher].

Tous les résultats pour les appels
d’offres en cours provenant de
l’Afghanistan s’affichent en bas de
l’écran. 11

Vous pouvez utiliser le moteur de recherche pour filtrer et 
afficher les appels d’offres en cours selon les critères suivants : 
« Country » [Pays], « Event ID » [Identifiant d’événement], 
« Event Name » [Nom de l’événement], « Event Type » [Type 
d’événement] ou « Status » [Statut]. 

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Pour filtrer et afficher des appels d’offres lancés par un pays 
spécifique, par exemple, l’Afghanistan, cliquez sur l’icône de 
loupe à côté de Event ID [Identifiant d’événement] et 
sélectionnez « Afghanistan » dans la liste déroulante.

Exemple



Il est possible de rechercher des événements en cours dans le système relativement à des articles spécifiques qui présentent un intérêt pour le 
soumissionnaire. Une fois que vous vous trouvez dans la zone de recherche, cliquez sur « Advanced Search Criteria » [Critères de recherche avancée], 
puis dans le champ « Item Description » [Description de l’article], saisissez le nom d’un article pour lequel vous souhaitez soumettre une offre.

12

2.1 Rechercher des appels d’offres – Recherche 
avancée

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Pour rechercher tous les événements en cours 
contenant « computer » [ordinateur] dans 
l’article, saisissez « computer » dans le champ 
« Item Description » [Description de l’article].

Cliquez sur « Search » [Rechercher] et 
consultez les résultats de la recherche qui 
s’affichent en dessous.

Exemple
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Pour rechercher un événement spécifique, accédez au champ « Event ID » [Identifiant d’événement], saisissez le nom de l’unité 
commerciale/le code de pays dans la première case à gauche, puis saisissez l’identifiant de l’événement (Event ID) dans la première case à 
droite.

Pour consulter les informations de 
l’événement et télécharger le dossier d’appel 
d’offres, cliquez sur le lien hypertexte « Event 
ID » [Identifiant de l’événement]. 13

2.1 Rechercher des appels d’offres – Télécharger un dossier 
d’appel d’offres

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Pour voir la proposition 0000001595 (Event 
0000001595), qui a été lancée par le siège 
du PNUD (Code UNDP1), saisissez les 
informations sous le champ « Event ID » 
[Identifiant de la proposition], comme 
illustré.  

Cliquez sur « Search » [Rechercher].

Exemple
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Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

2.1 Rechercher des appels d’offres – Télécharger un 
dossier d’appel d’offres

Lorsque vous êtes dans la page « Event Details » [Informations sur l’événement] correspondant à l’ qui vous intéresse, vous pouvez 
télécharger le dossier d’appel d’offres, en cliquant sur le lien « View bidding documents » [Voir le dossier d’appel d’offres] en haut à droite 
de la page. 
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2.1 Rechercher des appels d’offres – Télécharger un 
dossier d’appel d’offres

Pour télécharger le dossier d’appel d’offres, cliquez sur l’icône de loupe à côté de chaque fichier joint. Pour 
retourner à la page « Event Details » [Informations sur l’événement], cliquez sur « OK ».
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[Soumettre une 
offre]

Le document .xml n’est pas un document d’appel 
d'offres. Ce fichier permet à un soumissionnaire de 
préparer sa réponse à un appel d’offres hors ligne, puis 
de la téléverser sur le système au format .XML. Pour 
des informations complémentaires, veuillez cliquer ici.

IMPORTANT

Assurez-vous que les fenêtres contextuelles sont 
activées sur votre navigateur Internet avant de 
télécharger un document.

Conseil
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2.2 Participer à un appel d’offres – Accepter une invitation 
à une souscription

Cliquez sur « Accept invitation » [Accepter l’invitation] pour recevoir des avis automatiques chaque fois que 
l’appel d’offres est modifié.

16

Cliquer ici pour 
retourner à la 
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Submit Bid

[Soumettre une 
offre]

Veuillez noter que votre compte sera 
automatiquement désactivé après 
une période d’inactivité de trois mois. 
Dans ce cas, veuillez demander de 
l’aide au point focal chargé de la 
passation de marché correspondant à 
l’événement. Pour vous assurer de 
maintenir votre compte actif, 
connectez-vous plusieurs fois par 
mois.

IMPORTANT

Pour vous inscrire et poursuivre votre 
participation à un appel d’offres, vous 
devez vous inscrire au préalable.

Conseil
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2.2 Participer à un appel d’offres – Commencer à créer une réponse 
à un appel d’offres

17
Guide de l’utilisateur du système eTendering du PNUD à 

l’attention des soumissionnaires - janvier 2017

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Une fois que vous avez accepté une invitation à un événement, ouvrez la page « Event Details » [Informations sur l’événement] et 
cliquez sur « Bid on Event » [Soumettre une offre pour l’événement] afin de commencer à créer votre réponse.



2.2 Participer à un appel d’offres – Principales composantes d'une 
offre en ligne

18

Pour soumettre une offre sur le système eTendering, les soumissionnaires doivent généralement suivre les trois procédures principales 
suivantes :

➢ Satisfaire aux critères d'un appel d’offres

➢ Insérer les quantités et les prix unitaires pour les articles requis

➢ Téléverser des pièces justificatives

Suivez les instructions figurant dans le guide pour soumettre votre offre.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.2 Préparer une réponse à un appel d’offres – Satisfaire aux critères 
de l’appel d’offres

19

Il est possible que les soumissionnaires soient conviés à répondre à certaines questions dans le cadre d’un événement 
(critères d’appel d’offres). Les réponses seront utilisées dans l’évaluation finale des offres et lors de l’adjudication du marché 
concerné. Les critères d’appel d’offres peuvent varier selon le type de questions posées. Certaines nécessitent de répondre 
par « yes/no » [oui/non], d’autres peuvent impliquer la saisie de réponses alphabétiques ou numériques. Veuillez lire 
attentivement chacune des questions avant d’y répondre.

Offre requise : Lorsqu’une question 

est marquée par une étoile rouge, cela 
signifie qu’il est obligatoire de 
répondre à cette question pour 
soumettre une offre admissible.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Réponse idéale requise : 
Lorsqu’une question est marquée par 
un dossier et une étoile rouge, vous 
devez y répondre par une « réponse 
idéale ». Par exemple, dans la Question 
1 à gauche, la réponse idéale est 
« yes » [oui]. Vous ne pouvez que 
répondre « yes » à cette question.

Guide de l’utilisateur du système eTendering du PNUD à l’attention des soumissionnaires - janvier 2018



2.2 Préparer une réponse à un appel d’offres – Insérer les quantités et 
les prix unitaires

20

Insérez le prix de votre offre dans les champs requis.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Pour les appels d’offres, vous devez :
• Saisir 1 pour le prix de l’offre
• Téléverser votre offre financière sous forme de pièce jointe 

au format PDF protégée par un mot de passe

IMPORTANT

• La devise de l’offre de l’événement
• Les instructions dans le dossier d’appel 

d'offres (par exemple, une grille tarifaire 
détaillée est-elle demandée ? Une offre 
financière protégée par un mot de 
passe est-elle requise ? etc.)

Faites particulièrement
attention aux aspects 
suivants : 
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2.2 Préparer une réponse à un appel d’offres –
Téléverser les pièces justificatives

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Pour téléverser les pièces justificatives accompagnant votre offre, cliquez sur le lien « View/Add General 
Comment and Attachments » [Voir/ajouter un commentaire général et des pièces jointes] dans la page « Event 
Details » [Informations sur l’événement].

Guide de l’utilisateur du système eTendering du PNUD à l’attention des soumissionnaires - janvier 2018



22

2.2 Préparer une réponse à un appel d’offres – Téléverser 
les pièces justificatives

Cliquez sur « Upload » [Téléverser], puis sur « Browse » [Parcourir] pour localiser et sélectionner le fichier que 
vous souhaitez téléverser depuis votre ordinateur. Une fois que vous avez sélectionné le fichier, cliquez à nouveau 
sur « Upload » [Téléverser].

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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Pour téléverser un nouveau fichier, cliquez sur « Add New Attachment » [Ajouter une nouvelle pièce jointe], puis sur 
« Browse » [Parcourir] pour localiser et sélectionner le fichier que vous souhaitez téléverser. Une fois que vous avez 
sélectionné le fichier, cliquez à nouveau sur « Upload » [Téléverser].

2.2 Préparer une réponse à un appel d’offres –
Téléverser les pièces justificatives

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.2 Préparer une réponse à un appel 
d’offres – Téléverser les pièces justificatives

Il est important de veiller à ce que la description des pièces jointes (Attachment 
Description) et les noms des fichiers soient dans le format approprié. Veuillez lire 
les conseils pour des informations complémentaires.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

• Le nom du fichier ne peut pas contenir plus de 
60 caractères.

• Le nom du fichier et sa description ne peuvent 
contenir des caractères spéciaux ou des lettres 
d’autres alphabets. Seules les lettres de 
l’alphabet anglais sont autorisées.

• Si vous téléversez un grand nombre de fichiers 
(par exemple, 15 ou plus), veuillez les 
compresser dans un dossier au format .ZIP et 
téléverser le dossier plutôt que chaque fichier 
individuel. Vous pouvez téléverser plusieurs 
dossiers ZIP, mais dans ce cas, veuillez noter 
que la taille totale de chaque dossier ZIP à 
téléverser ne peut pas dépasser 50 Mo.

• Veuillez lire attentivement le dossier d’appel 
d’offres correspondant à l’événement afin de 
vous assurer que vous remplissez les critères de 
l’événement pour la soumission de documents. 
Il est possible que des restrictions soient 
imposées quant à la taille et au format des 
fichiers à téléverser.

Conseils pour téléverser des 
fichiers
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2.2 Préparer une réponse à un appel d’offres –
Enregistrer pour un usage ultérieur

Vous pouvez enregistrer votre réponse à un appel d’offres et y revenir ultérieurement pour y ajouter des informations 
complémentaires. Cliquez sur « Save for Later » [Enregistrer pour un usage ultérieur].

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.2 Préparer une réponse à un appel d’offres – Enregistrer 
pour un usage ultérieur

Un avis du système informera l’utilisateur que son offre est sur le point d’être enregistrée. Cliquez sur « OK » pour 
confirmer que vous souhaitez enregistrer l’offre pour un usage ultérieur.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Sachez que l’enregistrement de votre 
offre pour un usage ultérieur ne 
constitue pas une soumission de votre 
offre dans le système. Pour soumettre 
votre offre, vous devez cliquer sur 
« Submit Bid » [Soumettre l’offre].

IMPORTANT
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2.2 Préparer une réponse à un appel d’offres – Enregistrer pour un usage 
ultérieur

Pour revenir à votre offre enregistrée afin d’y ajouter des informations, ouvrez la page « Event Details » [Informations sur l’événement] 

en cliquant sur le lien hypertexte des événements, puis sur « View, Edit or Copy, from Saved Bids » [Afficher, modifier ou copier à 
partir d’offres enregistrées].

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.2 Préparer une réponse à un appel d’offres – Enregistrer pour un usage 
ultérieur

Sur la page suivante, le statut de votre offre est « Saved » [Enregistré]. Vous pouvez continuer à élaborer votre offre en 
cliquant sur le lien « Edit Bid Response » [Modifier la réponse à l’appel d’offres].
Ceci ouvre votre réponse à l’appel d’offres, et vous pouvez continuer à l’élaborer.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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Une fois que vous avez fini de préparer votre réponse à un appel d’offres, que toutes les pièces justificatives ont été 
téléversées et que vous êtes prêt(e) à soumettre votre offre, cliquez sur le bouton « Validate Entries » [Valider les saisies] 
pour vérifier que vous avez répondu correctement, selon les critères de l’appel d’offres, et que votre offre couvre tous les 
articles requis.

2.3 Soumettre une offre – Contrôler les réponses

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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Une fois que vous avez cliqué sur le bouton « Validate Entries » [Valider les saisies], le système vérifie que vous avez 
respecté les exigences minimales pour l’événement. Si vous n’avez pas répondu à toutes les questions obligatoires, un 
message d’erreur en caractères rouges s’affiche au sommet de la page « Event Details » [Informations sur l’événement].

30

2.3 Soumettre une offre – Contrôler les réponses

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Ce message d’avertissement indique que les 
réponses à la Question 2 et pour l’article 2 
sont obligatoires et qu’il faut y répondre avant 
la soumission.

Exemple
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2.3 Soumettre une offre – Soumettre une 
réponse à un appel d’offres

Une fois que votre offre est complète et que vos réponses ont été validées, cliquez sur le bouton « Submit Bid » [Soumettre 
l’offre] pour la publier dans le système.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre] Guide de l’utilisateur du système eTendering du PNUD à l’attention des soumissionnaires - janvier 2018
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2.3 Soumettre une offre – Publier une réponse à un 
appel d’offres

Une fois que vous avez cliqué sur le bouton « Submit Bid » [Soumettre l’offre], cliquez sur « OK » pour confirmer votre 
soumission. 

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.3 Soumettre une offre - Courriel de 
confirmation d’une offre 

33

Une fois que votre offre est publiée, vous devriez recevoir un courriel de confirmation de l’offre à 
l’adresse électronique que vous avez indiquée lors de votre inscription.
Le courriel comprend un fichier PDF qui présente une synthèse de votre offre générée par le 
système. 

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Il arrive parfois que le système ne 
génère pas de courriel de 
confirmation d’une offre. Si vous 
avez soumis une offre et que vous 
ne recevez pas de courriel de 
confirmation, cela ne vous 
empêche pas de confirmer le 
statut de votre offre dans le 
système. Cliquez ici pour suivre les 
instructions.

IMPORTANT

Ouvrez le fichier PDF et vérifiez que la 
synthèse de votre offre est correcte.

Conseil
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Ouvrez le fichier PDF reçu par courriel et accédez à la section « Bid Attachments » [Pièces jointes à l’offre] figurant à la fin du 
document. Cette section présente une liste des noms de tous les fichiers que vous avez téléversés pour votre offre. Contrôlez
toujours cette liste pour vous assurer d’avoir téléversé toutes les pièces justificatives qui sont requises. Étant donné que le 
système ne vérifie pas si les documents requis ont été soumis ou non, il incombe au soumissionnaire de veiller à ce que toutes 
les pièces justificatives aient bien été téléversées.

34

2.3 Soumettre une offre – Contrôler les pièces 
justificatives téléversées

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Contrôlez toujours cette liste pour vous assurer 
d’avoir téléversé toutes les pièces justificatives qui 
sont requises.

Conseil
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2.4 Préparer la soumission d'une offre hors ligne –
Soumettre une offre au format .XML

Les soumissionnaires ont la possibilité de préparer leurs réponses à un appel d’offres hors ligne, en téléchargeant le dossier 
d’événement complet sur leur ordinateur, au format .XML. 

Le dossier d’événement au format .XML contient toutes les exigences requises concernant l’appel d’offres et les articles, 
auxquelles le soumissionnaire doit satisfaire avant de soumettre son offre en ligne.

Pour ce faire, le soumissionnaire doit télécharger le fichier .XML, l’enregistrer en tant que fichier Excel sur son ordinateur, 
remplir les champs requis, puis téléverser sa réponse à l’appel d’offres dans le système eTendering.

Veuillez noter que, si vous décidez d’utiliser cette méthode optionnelle pour soumettre votre offre, vous devez également 
vous assurer d’avoir téléversé toutes les pièces justificatives nécessaires directement dans le système avant de soumettre votre 
offre.

35

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Télécharger le fichier .XML

Pour commencer à préparer votre réponse à un appel d’offres hors ligne, vous devez télécharger le fichier .XML sur votre ordinateur au 
préalable. Pour localiser le fichier .XML, accédez aux sections suivantes : « Event Details » [Informations sur l’événement] « Bidding 
Shortcuts » [Raccourcis vers l’offre], puis cliquez sur le bouton « View Bidding Documents » [Afficher les documents de l’offre].

36

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Télécharger le fichier .XML

Dans « Event Header Comments and Attachments » [Commentaires d’en-tête de l’événement et pièces jointes], trouvez le 
fichier nommé « Event Bid Package » [Dossier d’appel d’offres de l’événement] avec l’extension « .xml ». 

37

Téléchargez le fichier en cliquant sur l’icône de loupe.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Veuillez noter que le système génère un 
nouveau fichier .XML chaque fois qu’un 
événement est modifié. Assurez-vous 
d’utiliser la dernière version du fichier 
.XML lors de la soumission de votre offre.

IMPORTANT
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Télécharger le fichier .XML

38

Le fichier s’ouvre sous forme de nouvel onglet sur 
votre navigateur Internet. Téléchargez le fichier et 
enregistrez-le sur votre ordinateur. La méthode 
d’enregistrement dépend du navigateur que vous 
utilisez. Dans Firefox par exemple, vous devez 
cliquer avec le bouton droit de votre souris sur la 
page Internet et l’enregistrer en tant que fichier 
.xml à l’emplacement souhaité sur votre 
ordinateur.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Avant de télécharger le fichier .XML, veillez à ce que 
les fenêtres contextuelles soient activées sur votre 
ordinateur.

IMPORTANT
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Ouvrir le fichier .XML dans Excel

39

Ouvrez le fichier .xml enregistré dans Excel en allant dans « Excel » et en cliquant sur « Open » [Ouvrir] et sur «Browse » 
[Parcourir], puis recherchez l’emplacement du fichier. Une fois que vous avez trouvé le fichier, sélectionnez-le et cliquez sur 
« Open » [Ouvrir] pour l’afficher dans Excel.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Répondre à un appel d’offres dans Excel

40

Une fois que vous avez ouvert le fichier dans Excel, répondez à toutes les réponses présentées dans le document 
concernant les critères et les articles de l’appel d’offres.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Veuillez vérifier tous les onglets des feuilles de calcul en bas du 
fichier Excel et assurez-vous d’avoir répondu à toutes les questions 
dans des champs obligatoires.

IMPORTANT
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Téléverser une réponse et la soumettre

41

Une fois que vous avez rempli tous les champs, enregistrez le 

document en tant que feuille de calcul .XML, puis retournez à la 

page « Event Details » [Informations sur l’événement] dans le 

système eTendering pour téléverser votre offre. Allez dans 

« Bidding Shortcuts » [Raccourcis vers l’offre] et cliquez sur 

« Upload XML Bid Response » [Téléverser la réponse à l’appel 

d’offres au format .XML].

Cliquez sur le bouton « Select .XML File » [Sélectionner un 

fichier .XML] et choisissez le fichier que vous avez enregistré. 

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]
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2.4 Préparer une réponse à un appel d’offres hors ligne –
Téléverser une réponse et la soumettre

42

Lorsque le fichier .xml est téléversé, vos réponses 
s’affichent automatiquement dans la page « Event 
Details » [Informations sur l’événement]. Veuillez 
contrôler les réponses pour vous assurer que toutes 
les informations sont correctes, et ajoutez les pièces 
jointes éventuellement nécessaires avant de valider
vos saisies et de soumettre votre offre. Souvenez-
vous : il n’est pas possible de joindre des documents 
par le biais des fichiers .xml, il faut les téléverser 

directement dans le système.

Cliquer ici pour 
retourner à la 

page principale 
Submit Bid

[Soumettre une 
offre]

Vous ne pouvez téléverser votre offre au format .xml qu’une 
seule fois. Toute modification doit être effectuée en ligne dans le 
système en suivant ces instructions.

IMPORTANT
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3.0 Soumettre une offre

➢3.1 Afficher le statut des appels d’offres et les soumissions aux appels d’offres

➢3.2 Modifier une offre proposée 

➢3.3 Soumettre une autre offre

➢3.4 Annuler une offre

➢3.5 Gérer une offre après la modification d’un événement

➢3.5.1 Renouveler la soumission d’une offre lorsque l’offre est annulée 

43

Cliquer ici pour 
retourner à la 

table des 
matières

La présente section indique au soumissionnaire comment afficher, modifier ou annuler une offre qui est déjà 
enregistrée dans le système ou qui a été soumise. La section explique également comment les 
soumissionnaires peuvent renouveler la soumission d’ une offre lorsqu’un événement a été modifié.
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3.1 Gérer les offres – Afficher le statut et les réponses à un 
appel d’offres

Pour afficher votre réponse à un appel d’offres et vérifier le statut de votre offre, connectez-vous à votre compte eTendering et 
accédez à « Manage Events and Place Bids » [Gérer des événements et soumettre des offres]. Cliquez sur « My Event Activity » 
[Mes activités d’événements], puis sur « Event Bids On » [Offres actives pour des événements].  

Tous les événements d’appels d’offres auxquels vous avez participé s’affichent en-dessous. Cliquez sur l’identifiant d’événement
[Event ID] concerné pour examiner les détails de votre réponse à l’appel d’offres correspondant.

44

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.1 Gérer les offres – Afficher le statut et les réponses à un appel 
d’offres

Une fois que vous avez cliqué sur l’identifiant d’événement et que vous êtes dans la page « Event Details » [Informations 
sur l’événement], cliquez sur le lien « View, Edit or Copy From Saved Bids » [Afficher, modifier ou copier à partir d’offres 
enregistrées].

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.1 Gérer les offres – Afficher le statut et les réponses à un 
appel d’offres

Le statut de votre offre figure dans la colonne « Bid Status » [Statut de l’offre]. Pour assurer la bonne soumission d'une offre, 
le statut de l’offre doit indiquer « Posted » [Publiée]. Cliquez ensuite sur le lien « View » [Afficher]. Le système ouvre l’offre 
que vous avez publiée dans le mode ‘Lecture seule’ [View Only].

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]

Les autres statuts d’une offre sont les 
suivants : « Saved » [Enregistrée] ou 
« Cancelled » [Annulée]. Ces statuts indiquent 
tous qu’une offre n’a pas encore été publiée.

Conseil
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3.2 Gérer les offres – Modifier une offre

47

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]

Pour modifier la réponse à un appel d’offres, connectez-vous à votre compte eTendering et, dans le menu de gauche, cliquez sur 
« Manage Events and Place Bids » [Gérer des événements et soumettre des offres]. Cliquez sur « My Event Activity » [Mes 
activités d’événements] puis sur « Event Bids On » [Offres actives pour des événements].

Cliquez sur l’identifiant de l’événement concerné [Event ID].

Guide de l’utilisateur du système eTendering du PNUD à l’attention des soumissionnaires - janvier 2018



3.2 Gérer les offres – Modifier une offre si une modification directe 
n’est pas autorisée

48

Si la modification d’une offre est « not allowed » [non autorisée], le soumissionnaire doit d’abord annuler l’offre publiée 
en suivant les instructions ici, puis créer une nouvelle réponse à l’appel d’offres.

Une fois que l’offre a été annulée, vous pouvez créer une nouvelle réponse à l’appel d’offres à l’aide de la fonction de 
copie, qui vous permet de copier l’offre annulée. Procédez ensuite aux modifications nécessaires. Alternativement, vous 
pouvez créer une toute nouvelle réponse à l’appel d’offres en cliquant sur le lien « Bid On Event » [Soumettre une offre 
concernant l’événement].  

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]

Assurez-vous d’enregistrer ou de soumettre 
votre offre après l’avoir modifiée

IMPORTANT
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3.2 Gérer les offres – Modifier une offre quand une modification 
directe est autorisée

Si les modifications directes d’une offre publiée sont autorisées, le bouton « Edit Bid Response » [Modifier la réponse 
à un appel d’offres] s’affiche une fois que vous allez dans « View, Edit or Copy From Saved Bids » [Afficher, modifier 
ou copier à partir d’offres enregistrées]. Cliquez sur ce bouton pour commencer à modifier votre offre.

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]

Assurez-vous d’enregistrer ou de soumettre 
votre offre après l’avoir modifiée.

IMPORTANT
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3.3 Gérer les offres – Soumettre une offre alternative
Dans certains cas, le PNUD accepte des 
offres alternatives. Cela signifie que le 
soumissionnaire peut soumettre plusieurs 
offres dans le système, auquel cas l’une des 
offres est l’offre principale, et la ou les 
autre(s) sont des offres alternatives. 

Si vous souhaitez soumettre plusieurs offres 
pour un même événement, il est possible de 
copier l’offre principale afin d’éviter d’avoir 
à élaborer des réponses entièrement 
nouvelles.  

Pour ce faire, accédez à la page « Event 
Details » [Informations sur l’événement], 
cliquez sur « View, Edit or Copy from Saved 
Bids » [Afficher, modifier ou copier à partir 
d’offres enregistrées] et vérifiez si des offres 
multiples [Multiple Bids] sont autorisées 
[allowed], comme illustré ci-contre. Le cas 
échéant, le lien « Copy » [Copier] est actif. 

Cliquez sur « Copy » [Copier] et commencez 
à préparer votre réponse alternative à 
l’appel d’offres.

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]

Chaque fois que vous soumettez une offre 
alternative, assurez-vous de préciser dans 
votre document de proposition qu’elle est 
l’offre principale et celle(s) qui est/sont 
une/des offre(s) alternative(s).

Conseil
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3.4 Gérer les offres – Annuler une offre

51

Si vous devez annuler une offre, vous pouvez aller dans « View, Edit of Copy from Saved Bids » [Afficher, modifier ou copier 
à partir d’offres enregistrées] et cliquer sur le lien « Cancel » [Annuler].

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.4 Gérer les offres – Annuler une offre

52

Le système vous demandera de reconfirmer votre intention d’annuler votre offre en cliquant sur le bouton « Cancel this 
bid » [Annuler cette offre].

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.4 Gérer les offres – Annuler une offre

53

Si vous êtes certain(e) de vouloir annuler l’offre, cliquez sur « Yes » [Oui].

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.4 Gérer les offres – Annuler une offre

Après avoir annulé votre offre, le statut de l’offre devient « Cancelled » [Annulée].

54

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.4 Gérer les offres – Annuler une offre
Consultez le compte de messagerie électronique que vous avez utilisé lors de votre inscription pour vérifier si vous avez reçu un 
message confirmant l’annulation de votre offre.

55

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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3.5 Gérer les offres – Gestion d'une offre après la 
modification d'un appel d’offres

Si un appel d’offres est modifié, une nouvelle version de l’événement sera créée dans le système. Dans la plupart des 
cas, les offres publiées correspondant à l'ancienne version conserveront ce statut, mais il est important que le 
soumissionnaire vérifie que son offre satisfait aux exigences de la nouvelle version de l'événement.

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]

Si les modifications apportées à 
l’événement impliquent un 
changement des critères obligatoires 
ou des articles, le statut d’une offre 
précédemment publiée deviendra 
« cancelled » [annulée] ,et il vous 
faudra soumettre une nouvelle offre.

IMPORTANT
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3.5 Gérer une offre - Lorsqu’une offre est annulée après la 
modification d’un événement

Lorsque les modifications apportées à l’événement impliquent un changement des critères obligatoires ou des articles, le statut d'une offre 
précédemment publiée deviendra « cancelled » [annulée] ,et il vous faudra soumettre une nouvelle offre. Pour confirmer que leur offre a 
été annulée, les soumissionnaires reçoivent un avis automatique par courriel les informant qu'une nouvelle version de l’événement a été 
créée et que la dernière offre qu'ils ont soumise relativement à cet événement a été annulée. 

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid
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Pour soumettre une nouvelle réponse à un appel d’offres suite à l’annulation d’une offre en raison de la modification de l’événement correspondant, 
accédez à la page « Event Details » [Informations sur l’événement] et cliquez sur le bouton « Bid on Event » [Soumettre une offre pour l’événement]. 
Suivez les mêmes étapes que celles qui figurent dans la section présentant comment soumettre une offre [Submit a Bid].

3.5 Gérer une offre - Lorsqu’une offre est annulée 
après la modification d’un événement

Cliquer ici pour 
retourner à la 

page principale 
Manage Bid

[Gérer une offre]
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4.0 Enregistrer un profil de soumissionnaire

➢ Introduction à l’inscription des 
soumissionnaires

➢Action 1 : Connexion avec event.guest

➢Action 2 : Cliquer sur « Register Bidder » 
[Inscription d'un soumissionnaire]

➢Action 3 : Enregistrer les informations du 
profil

➢Action 4 : Confirmer l’inscription et créer un 
nouveau mot de passe

59

Les soumissionnaires qui utilisent eTendering pour la première fois doivent s’inscrire pour créer un 
compte d’utilisateur soumissionnaire avant de pouvoir participer à un événement dans le système 
eTendering. Cette section fournit un aperçu rapide présentant le processus d’inscription des 
soumissionnaires, la manière de se connecter pour démarrer l’inscription ainsi que la méthode pour 
enregistrer votre profil de soumissionnaire, en 8 étapes. 

2 points clés à retenir :

1. Vous ne devez vous inscrire pour un compte 

qu’une seule fois

2. C’est aux soumissionnaires et non au PNUD 

que revient la responsabilité de gérer l’accès 

des parties individuelles à leur compte

Cliquer ici pour 
retourner à la 

table des 
matières
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Uniquement lors de sa toute première connexion au système eTendering, le soumissionnaire doit procéder à 
son inscription. Les soumissionnaires ne s’inscrivent qu’une seule fois, puis accèdent au système eTendering à 
l’aide de leur nom d’utilisateur et de leur mot de passe. 

Introduction à l’inscription des soumissionnaires

60

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Action 1
Connexion avec

event.
guest

Action 2
Cliquer sur « Register

Bidder » [Inscrire 
un soumissionnaire]

Action 3
Enregistrer les 

informations du profil 
de soumissionnaire

Action 4
Confirmer l’inscription et

créer un nouveau 
mot de passe
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Action 1 : Connexion avec event.guest
[invité.événement]

Pour démarrer l’inscription, les utilisateurs qui se connectent pour la première fois 
doivent utiliser les identifiants génériques ci-dessous afin d’accéder au site du 
système eTendering :

✓ Nom d’utilisateur : event.guest
✓ Mot de passe : why2change
✓ Lien : https://etendering.partneragencies.org

why2change

61

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Si vous êtes déjà inscrit(e) dans le système, mais que 
vous ne vous souvenez pas de votre mot de passe, 
veuillez ne pas vous réinscrire.  

Si vous avez oublié votre mot de passe, cliquez sur le 
lien « Forgotten Password » [Mot de passe oublié] et 
créez un nouveau mot de passe.

IMPORTANT
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Action 2 : Cliquer sur « Register Bidder » 
[Inscription d’un soumissionnaire]

Une fois que vous êtes connecté(e) au compte event.guest, accédez au menu déroulant de gauche dans la page principale et 
agrandissez le menu « Manage Events and Place Bids » [Gérer des événements et soumettre des offres].
Cliquez sur le lien « Register Bidder » [Inscription d’un soumissionnaire].

62

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Une fois que vous avez cliqué sur ce lien, il peut 
falloir 3 à 4 minutes pour que le système 
charge la page suivante. Veuillez patienter 
jusqu’à ce que la page finisse de se charger, 
sans cliquer sur d’autres liens. 

L’icône pivotante en haut à droite de la page 
indique que le chargement de la page est en 
cours.

IMPORTANT
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Lors de la première étape de l’inscription, le 
soumissionnaire doit indiquer s’il est une entreprise 
[Business] ou une personne physique [Individual], et 
s’il souhaite acheter ou vendre des biens et/ou des 
services, ou les deux.

Étape 1 : Sélectionner le type de 
soumissionnaire

63

Action 3 : Enregistrer les 
informations du profil de 
soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Pour la Question 2, sélectionnez toujours l’option « Both » 
[Les deux]. Ceci permet au soumissionnaire de consulter 
tous les appels d’offres en cours.

Conseil
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Étape 2 : Créer un profil de société et des utilisateurs

Tous les champs marqués par une astérisque * doivent être remplis

*Company Name [Nom de société] : 
✓ Doit correspondre au nom officiel enregistré auprès du bureau 

d’enregistrement compétent. 
✓ Les caractères spéciaux ne sont pas autorisés pour les noms de société.
✓ Si vous saisissez le nom d’une société qui existe déjà dans le système, un 

message d’erreur s’affiche. Veuillez cliquer ici pour de l’aide.

*« First and Last names » [Prénom et nom de famille] : 
✓ Nom de la personne autorisée par votre société à utiliser le système et à la 

représenter.

*« Email ID » [Identifiant de courriel] : 
✓ Doit être une adresse électronique valide pour votre société. Veuillez noter 

que toutes les communications futures provenant du système seront 
envoyées à cette adresse. 

*« User ID » [Identifiant d’utilisateur] : 
✓ Il est vivement recommandé de créer un nom d’utilisateur en deux parties 

séparées par un point. Par exemple : nom.société
✓ Dans l’idéal, le nom d’utilisateur doit être lié à celui de la société plutôt 

qu’au nom de l’utilisateur.
✓ Les caractères spéciaux et les espaces ne sont pas autorisés pour les 

identifiants d’utilisateur.
✓ Si vous saisissez un identifiant d’utilisateur qui existe déjà dans le système, 

un message d’erreur s’affiche. Veuillez cliquer ici pour de l’aide.

64

Action 3 : Enregistrer les informations du 
profil de soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Il est conseillé d’ajouter au moins 2 utilisateurs afin que 
plusieurs personnes de la même société puissent accéder 
au site eTendering. Pour ajouter un autre utilisateur, 
cliquez sur le bouton « Save and Add Another User » 
[Enregistrer et ajouter un autre utilisateur] ; sinon, cliquez 
sur le bouton « Next » [Suivant] pour passer à la 3e étape.

Conseil
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Étape 2 (suite) : Ajouter plus d'utilisateurs

Si vous avez cliqué sur le bouton « Add Another User » 
[Ajouter un autre utilisateur], le système vous invite à saisir 
de nouvelles informations.

Chaque utilisateur disposera de son identifiant d’utilisateur et 
de son mot de passe propres.

Cliquez sur le bouton « Save and Add another User » 
[Enregistrer et ajouter un autre utilisateur] pour ajouter un 

autre utilisateur ou cliquez sur le bouton « Next » [Suivant] si 
vous avez terminé.

65

Action 3 : Enregistrer les informations du 
profil de soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Après l’enregistrement, si vous devez mettre à jour l’un quelconque des profils 
d’utilisateur, consultez la section « Manage Bidder Profiles » [Gérer les profils de 
soumissionnaire].

Conseil
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Étape 3 : Saisir l’adresse de la société 

À l’étape 3, l’adresse du soumissionnaire est 
requise. Veuillez faire particulièrement attention 
au pays sélectionné. Pour tous les profils de 
soumissionnaire, le système sélectionne les États-
Unis par défaut. S’il ne s’agit pas du pays de 
l’adresse du soumissionnaire, veuillez vous 
assurer de le modifier selon les besoins, en 
cliquant sur le bouton « Change Country » 
[Modifier le pays] et en sélectionnant le pays 
concerné dans le menu déroulant.

Les soumissionnaires peuvent remplir les champs 
obligatoires* et laisser les autres champs vides.

Une fois que vous avez rempli cette section, 
cliquez sur le bouton « Next » [Suivant].

66

Action 3 : Enregistrer les 
informations du profil de 
soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]
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Étape 4 : Ajouter d’autres adresses de société

L’étape 4 est facultative. Cliquez sur le bouton « Next » [Suivant] 
pour passer à l’étape suivante.

67

Action 3 : Enregistrer les 
informations du profil de 
soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]
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Étape 5 : Renseignez les adresses pour
des utilisateurs supplémentaires

Il est possible d’ignorer l’étape 5, car elle est 

facultative. Cliquez sur le bouton « Next » 
[Suivant] pour passer à l’étape suivante.

68

Action 3 : Enregistrer les 
informations du profil de 
soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]
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Étape 6 : Accepter les Conditions générales

La dernière étape du processus d’inscription est 
l’acceptation des Conditions générales. Veuillez lire 
attentivement les Conditions générales. 

Si vous les acceptez, veuillez cocher la case « I agree to be 
bound by the following Terms and Conditions » [J’accepte 
de me soumettre aux Conditions générales suivantes], puis 
cliquez sur le bouton « Finish » [Terminer].

Si vous n’acceptez pas les Conditions générales stipulées, 
cliquez sur le bouton « Cancel Registration » [Annuler 
l’inscription].

69

Action 3 : Enregistrer les 
informations du profil de 
soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]
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Étape 7 : Terminer l’inscription d’un soumissionnaire

Une fois que vous avez accepté les Conditions générales, le message suivant s’affiche, confirmant que l’inscription a réussi :

Cliquez sur « OK » pour terminer

votre inscription de soumissionnaire.

70

Action 3 : Enregistrer les informations du profil 
de soumissionnaire

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]
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✓ Un mot de passe temporaire

✓ Votre identifiant d’utilisateur 

✓ Des instructions sur la manière de créer un nouveau mot de passe pour votre compte eTendering.

71

Action 4 : Confirmer l’inscription et créer un 
nouveau mot de passe

Une fois que votre inscription en ligne est terminée, vous recevrez un courriel automatique de confirmation. Le courriel 
contient les éléments suivants :

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

• Vous ne pouvez utiliser le mot de passe temporaire qu’une 
seule fois.

• Vous devez créer un nouveau mot de passe pour vous 
connecter à votre compte et pour afficher les événements.

IMPORTANT
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1) Lorsque vous vous connectez pour la première fois au système 
eTendering, ce dernier vous invite à créer un nouveau mot de passe de 
votre choix. Saisissez l’identifiant d’utilisateur et le mot de passe 
temporaire que vous avez reçus dans le courriel confirmant votre 
inscription (consulter la diapositive précédente). Cliquez sur le bouton 
« Login » [connexion]. Ne cliquez pas sur « Change Password »
[Modifier le mot de passe].

72

2) Créez votre nouveau mot de passe en saisissant 
d’abord votre mot de passe temporaire, puis saisissez 
un mot de passe de votre choix répondant aux critères 
ci-dessous. Cliquez ensuite sur le bouton « Change 
Password » [Modifier le mot de passe].

Votre nouveau mot de passe doit satisfaire aux critères 
suivants :

1

2

Cliquer ici pour 
retourner à la 

page principale 
Register Profile
[Enregistrer un 

profil]

Avant de vous connecter avec votre mot de passe temporaire, veuillez procéder comme 
suit :
• Effacez l’historique de votre navigateur Internet et fermez votre navigateur
• Rouvrez le navigateur, et accédez à l’adresse : http://etendering.partneragencies.org
• Saisissez l’identifiant d'utilisateur et le mot de passe – n’effectuez pas un 

copier/coller

IMPORTANT

✓ Contenir au moins 8 caractères.
✓ Contenir au moins une LETTRE MAJUSCULE.
✓ Contenir au moins une lettre minuscule.
✓ Contenir au moins un chiffre.

Action 4 : Confirmer l’inscription et 
créer un nouveau mot de passe
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5.0 Gérer un profil de soumissionnaire

➢5.1 Afficher les activités de soumission d’offres

➢5.2 Gérer des profils de soumissionnaire

➢5.3 Gérer l’accès des utilisateurs

73

La présente section décrit certaines fonctions supplémentaires du système eTendering qui 
permettent aux soumissionnaires d’afficher leurs activités de soumission d’offres et de mettre à jour 
les informations dans leur profil de soumissionnaire.

Cliquer ici pour 
retourner à la 

table des 
matières
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5.1 Afficher les activités de soumission d’offres
Pour afficher vos activités de soumission d’offres, cliquez sur « View Events and Place Bids » [Afficher les événements et 
soumettre des offres]  « My Event Activity » [Mes activités d’événements]  « Event Bids On » [Offres actives pour des 
événements].
Tous les événements d’appels d’offres auxquels vous avez participé s’affichent.

74

Cliquer ici pour 
retourner à la 

page principale 
Manage Profile
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5.2 Mettre à jour des profils de soumissionnaire

Pour mettre à jour votre profil de soumissionnaire, 
accédez à « Manage Events and Place Bids » [Gérer 
des événements et soumettre des offres] « My 
Bidder Profile » [Mon profil de soumissionnaire] et 
mettez à jour les informations selon les besoins.

• Veuillez noter que vous ne pouvez pas modifier le 
nom d’utilisateur.

• Mettez à jour les informations d’utilisateur telles 
que les adresses électroniques ou les numéros de 
téléphone, selon les besoins. S’il y a plusieurs 
utilisateurs et que vous souhaitez mettre à jour 
leur profil, cliquez sur la flèche en haut à droite 
pour accéder au profil de l’utilisateur suivant, 
comme illustré ci-contre.

Cliquez sur le bouton « Save » [Enregistrer] une fois 
que vous avez terminé.

75

Cliquer ici pour 
retourner à la 

page principale 
Manage Profile
[Gérer un profil]
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5.3 Gérer l’accès des utilisateurs

Si un utilisateur inscrit a quitté votre société et 
que vous souhaitez réassigner son nom 
d’utilisateur à un autre employé, connectez-vous à 
votre compte, accédez à l’onglet « My Bidder 
Profile » [Mon profil de soumissionnaire] et 
mettez à jour les adresses électroniques, les noms 
et les numéros de téléphone, selon les besoins. 

Cliquez sur la flèche en haut à droite pour accéder 
au profil de l’utilisateur inscrit suivant.

Une fois que vous avez mis à jour une adresse 
électronique, utilisez la fonction « forgotten 
password » [Mot de passe oublié] pour 
réinitialiser le mot de passe. Un nouveau mot de 
passe sera envoyé à la nouvelle adresse 
électronique. Suivez les étapes pour modifier le 
mot de passe.

76

Cliquez sur « Save » [Enregistrer] une fois 
que vous avez terminé.

Cliquer ici pour 
retourner à la 

page principale 
Manage Profile
[Gérer un profil]
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6.0 Service d’assistance

➢6.1 Assistance technique

➢6.2 Ressources complémentaires pour les soumissionnaires

➢6.3 Questions fréquemment posées

➢6.4 Mot de passe oublié

77

La présente section fournit des détails sur la personne à contacter pour de l’aide et sur la manière de 
résoudre certaines des questions fréquemment soulevées, et indique où trouver des ressources 
complémentaires au sujet du système eTendering.

Cliquer ici pour 
retourner à la 

table des 
matières
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6.1 Assistance technique

Si vous rencontrez des problèmes techniques lors du processus de soumission d’une offre, veuillez contacter le

point focal du bureau chargé de la passation de marché qui figure dans le dossier de l’appel d’offres auquel vous

souhaitez participer.

Pour vous assurer que votre cas sera résolu dans les meilleurs délais, lorsque vous sollicitez l’aide du service

d’assistance, il est toujours recommandé de communiquer les informations suivantes :

• Votre identifiant d’utilisateur et le nom de votre société

• L’identifiant de l’événement auquel vous participez (le cas échéant)

• Des images d’écran présentant les erreurs ou les messages d’avertissement éventuel(le)s

• Une courte description des étapes que vous suiviez avant de rencontrer des erreurs ou des problèmes

78

Veuillez vous assurer de toujours préparer et soumettre votre offre bien avant la date d’échéance de

l’événement afin de pouvoir avoir le temps de résoudre tout problème éventuel.

Cliquer ici pour 
retourner à la 

page principale 
« Helpdesk 
Support »
[Service 

d’assistance]
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6.2 Ressources complémentaires

79

Pour consulter les ressources complémentaires sur le système eTendering, y compris des vidéos de guides de 

l’utilisateur et des versions traduites du présent Guide de l’utilisateur (en français, en espagnol, en chinois, en arabe 

et en russe), accédez à la page d’avis de marchés du PNUD http://procurement-notices.undp.org/ et cliquez sur le 

bouton « More Information for Bidders » [Informations complémentaires pour les soumissionnaires] en bas à 

gauche de la page.
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6.3 Questions fréquemment posées

Lors de l’inscription :

Je viens de me connecter dans event.guest pour démarrer l’inscription, mais le système est très lent et ne semble pas se charger correctement.

Une fois que vous avez cliqué sur « Register Bidder » [Inscrire un soumissionnaire], il peut falloir 3 à 4 minutes pour que le système charge la page 
suivante. Veuillez patienter, et ne cliquez pas sur d’autres liens. Vous pouvez également tenter d’actualiser votre navigateur si le chargement dure 
plus de 4 minutes. Si le problème persiste, veuillez contacter votre point focal chargé des passations de marché pour une aide complémentaire.

Le nom de société que je souhaite utiliser pour enregistrer mon profil de soumissionnaire existe déjà dans le système. Que puis-je faire ?

Si votre société n’a jamais été inscrite dans le système eTendering auparavant et que vous recevez un message d’erreur indiquant que ce nom de 
société est déjà utilisé, veuillez modifier légèrement le nom de société, en sachant que les caractères spéciaux ne sont pas autorisés. Pour des 
informations complémentaires, veuillez cliquer ici.

Si vous vous êtes déjà inscrit(e) pour créer un compte de soumissionnaire précédemment, mais que vous ne vous souvenez pas de vos identifiants, 
veuillez ne pas inscrire un nouveau compte. Accédez plutôt à la section « Forgotten Passwords » [Mots de passe oubliés].

Le nom d’utilisateur que je souhaite utiliser pour enregistrer mon profil de soumissionnaire existe déjà dans le système. Que puis-je faire ?

Si vous ne vous êtes jamais inscrit(e) en tant qu’utilisateur sur le système eTendering auparavant et que vous recevez un message d’erreur 
indiquant que le nom d’utilisateur est déjà utilisé, veuillez sélectionner un nom d’utilisateur différent. Pour des informations complémentaires, 
veuillez cliquer ici.

Si vous vous êtes déjà inscrit(e) pour créer un compte de soumissionnaire, mais que vous ne vous souvenez pas de vos identifiants, veuillez ne pas 
inscrire un nouveau compte. Accédez plutôt à la section « Forgotten Passwords » [Mots de passe oubliés].
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6.3 Questions fréquemment posées

J’ai reçu le mot de passe temporaire après mon inscription, mais quand j’essaye de me connecter au système pour activer mon 

compte, je reçois un message d’erreur.

Veuillez consulter les instructions concernant la création d’un nouveau mot de passe. Si le système continue à vous envoyer un 

message d’erreur après plusieurs tentatives, veuillez contacter le centre d’assistance.

Problèmes de connexion

Je ne me souviens pas de mon mot de passe.

Pour réinitialiser votre mot de passe, veuille accéder à la section « Forgotten Passwords » [Mots de passe oubliés].

Je ne me souviens pas de mon nom d’utilisateur.

Si vous ne vous souvenez pas de votre nom d’utilisateur, veuillez contacter le point focal du bureau chargé des passations de marché 
figurant dans le dossier de l’appel d’offres auquel vous souhaitez participer.

Lors de la soumission d’une offre

Je ne parviens pas à télécharger le dossier d’appel d’offres.
Veuillez vous assurer que les fenêtres contextuelles sont activées dans votre navigateur Internet. Pour des informations 
complémentaires sur la manière d’afficher et de télécharger un dossier d’appel d’offres, cliquez ici.
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Gestion de votre compte

Puis-je mettre à jour les coordonnées figurant dans mon profil de soumissionnaire ?

Oui. Pour mettre à jour votre profil de soumissionnaire et celui d’autres utilisateurs inscrits dans votre profil, accédez à 

« Manage Events and Place Bids » [Gérer des événements et soumettre des offres] « My Bidder Profile » [Mon profil de 

soumissionnaire] et mettez à jour les informations selon les besoins. Voir la Section 5.0 « Manage Bidder Profile » [Gérer un 

profil de soumissionnaire] pour de plus amples informations.

Pourquoi est-ce que je reçois un message d’erreur quand je tente de téléverser un document dans le système ?
Lors du téléversement de fichiers, veuillez noter les restrictions suivantes :
• Le nom du fichier ne peut pas contenir plus de 60 caractères.
• Si vous téléversez un grand nombre de fichier (par exemple, 15 ou plus), veuillez les compresser dans un dossier au format .ZIP et 

téléverser le dossier plutôt que chaque fichier individuel. Vous pouvez téléverser plusieurs dossiers ZIP, mais dans ce cas, veuillez 
noter que la taille totale de chaque dossier ZIP à téléverser ne peut pas dépasser 45 Mo.

• La taille des fichiers individuels ne peut pas dépasser 45 Mo.
Pour des informations complémentaires sur le téléversement de fichiers, veuillez cliquer ici.

J’ai soumis mon offre, mais je n’ai pas reçu de courriel confirmant mon offre.
Si vous ne recevez pas de courriel de confirmation, vous pouvez confirmer le statut de votre offre et vérifier si elle a été publiée 
directement sur le système. Veuillez cliquer ici pour voir des informations complémentaires sur l’affichage de votre offre.

6.3 Questions fréquemment posées
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Accédez au site www.etendering.partneragencies.org et 
cliquez sur le lien « Forgotten password » [Mot de passe 
oublié].

Le système vous invitera à saisir votre identifiant 
Atlas, c’est-à-dire l’identifiant d’utilisateur que vous 
avez sélectionné lors de votre inscription et les 
adresses électroniques associées. Cliquez sur le 
bouton « Submit » [Envoyer].

1 2

Si vous avez oublié votre mot de passe, veuillez suivre la procédure suivante :
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La question de sécurité que vous avez sélectionnée lors du 
processus d'inscription s’affiche. Saisissez la réponse 
appropriée et cliquez sur « Submit » [Envoyer].

Un courriel automatique sera envoyé à l’adresse 
électronique de l’utilisateur concerné. Utilisez le mot de 
passe fourni dans le courriel pour vous connecter au 
système eTendering. Après la première connexion, le 
système invitera l’utilisateur à modifier le mot de passe.

3

4

Avant de vous connecter avec votre mot de passe temporaire, veuillez procéder comme 
suit :
• Effacez l’historique de votre navigateur Internet et fermez votre navigateur
• Rouvrez le navigateur, et accédez à l’adresse : http://etendering.partneragencies.org
• Saisissez manuellement l’identifiant d’utilisateur et le mot de passe – n’effectuez pas 

un copier/coller 

IMPORTANTVeuillez noter que la réponse à la question de sécurité est 
sensible à la casse. Assurez-vous que la réponse est saisie 
exactement comme lors de votre inscription.

Conseil

Votre nouveau mot de passe doit satisfaire aux 
critères suivants :
• Contenir au moins 8 caractères.
• Contenir au moins une LETTRE MAJUSCULE.
• Contenir au moins une lettre minuscule.
• Contenir au moins un chiffre.

Conseil
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Merci d’utiliser le système eTendering du PNUD !

Pour consulter des ressources supplémentaires telles 
que des vidéos d’instructions destinées aux 

soumissionnaires et ce Guide de l’utilisateur dans 
d’autres langues, veuillez cliquer ici.
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